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PLEASE DO NOT MAKE ILLEGAL COPIES OF THIS SOFTWARE
The software you are using was produced through the efforts 
of many people: designers, artists, programmers, distributors, 
retailers and other dedicated professionals.

The costs of developing this and other software programs are recovered
through software sales.  The unauthorized duplication of personal computer
software raises the cost to all legitimate users.

This software is protected by federal copyright law.  Copying software for any
reason other than to make a backup is a violation of law.  Individuals who
make unauthorized copies of software may be subject to civil and criminal
penalties.

Brøderbund Software, Inc. supports the industry’s efforts to fight illegal copying
of personal computer software.

Report copyright violation to:
SPA, 1730 M Street, NW
Washington, D.C.  20036
(202) 452-1600

TTAABBLLEE  OOFF  
CCOONNTTEENNTTSS
Getting Started
page 4

Tutorial
page 6
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page 11

The Menus
page 24

How to Contact
Technical Support
page 30
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What you will need:
•Windows 3.1 or Windows 95

•25MHz 486SX or faster

•8MB RAM 

•Minimum 10MB hard disk space 

•2X CD-ROM drive or faster 

•640x480 display, 256 colors 

•Windows compatible sound device

•Printer support: Works with most popular printers 
(monochrome and color) supported by Windows.

*System configuration: May require minor adjustments to
the configuration of your operating system and/or updates
to the hardware component drivers.

Installing the Software:

To Install Windows 95

• Begin at the Windows 95 desktop.  

• Insert the CD-ROM into your CD-ROM drive.   

•The Sticker Works startup window will appear.  

• Click the Install button and follow the on-screen 
instructions to install the program.  

If the Sticker Works startup window does not appear automat-
ically on screen, you can install the program manually:  

• Click the Start button on the taskbar and choose Run. 

•Type D:\SETUP.EXE in the line labeled Open.  
(If your CD-ROM drive uses a letter other than D, 
substitute that letter for D.)  

•Click the OK button and follow the on-screen instructions 
to install Sticker Works.

G E T T I N G  S T A R T E D
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To Play 

•Begin at the Windows 95 desktop.  

•Click the Start button, point to Programs, and then 
Brøderbund Software. 

•Click the Sticker Works 1.0 menu item to start the 
program.

To Remove from Windows 95

If you need to remove Sticker Works begin at the Windows
95 desktop.  Click the Start button, point to Settings, and then
click Control Panel. Double-click the Add/Remove Programs
icon.  Click the Install/Uninstall tab and select Sticker
Works from the list of programs. Click the Add/Remove…
button and then click the Yes button to remove the program.
Click OK to clear the screen.

To Install Windows(R) 3.1x 

•Begin at the Windows Program Manager. 

•Insert the CD-ROM into your CD-ROM drive. 

•Click the File menu, and select Run. 

•Type D:\SETUP.EXE in the line labeled Command Line.  
(If your CD-ROM drive uses a letter other than D, 
substitute that letter for D.) 

•Click the Install button and follow the on-screen 
instructions to install the program.

To Play

After successfully installing the program, a program group titled
Brøderbund Software will be created in the Windows
Program Manager. It will contain an icon labeled Sticker
Works. Double-click this icon to begin playing.

If you need to remove Sticker Works, begin at the Windows
Program Manager.  Double-click the Brøderbund Software
program group.  Next, double-click the Uninstall Sticker
Works icon. When prompted, click the Yes button to remove
the program. Click OK to clear the screen.
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Your First Sticker Works Sticker

Making your own sticker can be fun.  Our easy–to–learn, 
useful tools help you create unique designs in the shortest 
time possible.  

Some of you may want to jump right in and begin experimenting
immediately.  That’s fine. . . skip this section and go for it!
However, if you would like to understand how everything works
in a more logical order, take a few minutes to walk through this
section.

RREEAADDYY??
Make sure that you’ve installed the application as outlined
above.  Start the Sticker Works application (refer to the “To
Play” paragraphs for Windows 3.1 or Windows 95 in the
Getting Started section beginning on page 4).

You’ll enter the main work area where you will do most of your
sticker creation.

One of the great things about Sticker Works is that there is no
“right” way to create a sticker.  You can add text and graphics,
change colors, flip, rotate, and resize in any order you like.
Follow our example here and then do it whatever way works for
you.

Let the fun begin!

Let’s begin by adding color to the background.  

• Click the FILL button. 

In the dialog box that appears, you can select
from several different types of background fills.

• Select Radiant by clicking the radio but-
ton next to it.  A Radiant blend merges from

T U T O R I A L
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one color on the edge of the sticker (Fill Color) to another
color at the center of the sticker (Blend Color).

You’ll notice that after you choose a Fill Type, a preview of that
fill is shown in the area to the right.  To make the effect a little
more interesting, we are going to add different colors.

• Click and hold the mouse button down on the Fill Color
button.

In the small window that appears, move your mouse over the col-
ors (remember, keep the mouse button held down) and notice
that the Fill Color button reflects the color the mouse is 
pointing to.  When you've located a color you like, let go of the
mouse button.  You have now selected a Fill Color.

Notice that the preview of the effect has changed.

• Click and hold the Pointer on the Blend Color button. 
Select a color just as you did when selecting the first 
color.  Make sure the second color is different from the 
first color, or you won't get the desired effect.

After you have selected a second color, look at the preview.  It
will show you how the effect and colors you have chosen will
appear on your sticker.

• Click the ADD button when finished choosing colors 
and type of fill.

Now that you've set the background for your sticker, it's time to
start adding text and graphics.

• Click the GRAPHIC button.

In the dialog box that appears, you will be able to select from 
several different graphics types to add to your sticker.  You can
select Center or Border graphic, or if you own one of The Print
Shop® family of products, you can add a Print Shop® Square
graphic.  The Import button will allow you to import graphics in
BMP, TIFF, EPS or WMF format.  For more information about
graphic types, refer to the Add Graphic section, on page 18.
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LLEETT’’SS  KKEEEEPP  TTHHEE  FFIIRRSSTT  OONNEE  SSIIMMPPLLEE..

•Select Border Graphic

In the list of graphics that appears, select "Palm Trees" by
clicking on it with the Pointer.  The name will be highlighted, and
a preview of the border will appear in the right side of the 
dialog.

• Click the ADD button.

This will add the border to your sticker.

• Click the GRAPHIC button again.

The same dialog box appears.  This time, we'll add a graphic.

• Select Center Graphic

In the list of graphics that appears, select "Gone Surfin’" by
clicking on it with the Pointer.  You may have to scroll down the
list to find the graphic.  Just click on the downward pointing
arrow.  

• Click the ADD button.

This will add the graphic to your sticker.

HHEEYY,,  YYOOUU''RREE  AALLMMOOSSTT  DDOONNEE!!
The last thing that we'll do is to add text to your
sticker.

• Click the TEXT button.

Now you're ready to enter your text. You will notice a flashing
cursor is in the Line 1 area of the dialog box.  

• Type "I am stuck on" 

Press the Tab key or click in the Line 2 field.  This will make
the cursor active in the Line 2 area of the dialog box.

• Type "Sticker Works"
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The only thing left to do is change our font to
something that fits the mood.  

• Click the Font drop-down menu.

• Select "Steamer"

We will leave the Shape option set to “Border
Text.” Now, let's see what it looks like!

• Click the ADD Button.

You will return to the main work area and the text will be placed
around the center of the sticker.  

AADDVVAANNCCEEDD  SSTTUUFFFF
How about coloring the text?

Sure!  All monochrome (black and white) objects can be given a
different color.

• Make sure the Text Block is selected.

A selected object will appear with a rectangle around it.
If  the object is not selected, click the ITEM button until 
the rectangle appears around it. 

• Click and hold the mouse button down on the COLOR
button.

A color palette will appear where you can choose from 256 dif-
ferent colors for your text.  Move the mouse
over the different colors.  As you do, the
COLOR button changes its color to match.
Select a bright color that will make the text
stand out.  You can select a color by simply let-
ting up on the mouse button.

• How about bright blue?

After letting up on the mouse button, the text will
change to the color you have chosen.  
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SSAAVVIINNGG
It is highly recommended that you save your project
after you create your first sticker.

• Click the File menu and choose Save.

Name your project and enter a description as well.  This 
information will prove to be helpful if you ever decide to 
transport these stickers into another Sticker Works project.  
After naming your project, click OK and your project will be
saved.

YYOOUU  HHAAVVEE  NNOOWW  FFIINNIISSHHEEDD  YYOOUURR  FFIIRRSSTT  SSTTIICCKKEERR!!    
Congratulations!  Now go ahead and make some more of 
your own.

• Click the right navigational arrow located to the right 
of The Grid.

This will advance you to the next sticker, where you can begin
designing your own.

CCOOOOLL..
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SSTTIICCKKEERR  DDEESSIIGGNN
You can perform all sorts of design operations on sticker objects
using the buttons and menus. You can add, move, and delete
objects. You can add shadows, tint objects, and change colors
of black & white graphics. You can scale and resize, rotate and
flip, copy and paste, and change the order of the objects. You’ll
do all your work in the main window and see the results of your
changes instantly.  That means you can experiment, trying out
this or that until you come up with a design you like. 

If you plan to do a lot of tinkering with the design, you may
want to save your project whenever you have part of a design
you’re sure you want to keep. That way, if your experimentation
leads to confusion, you’ll be able to get the original project back
by using the Revert to Saved option on the File menu. For
details on saving your project, see page 16. 

Selecting Objects

Before performing a design operation, you must select the object
or objects you want to change. You can select one, several, or
all of the objects in the design. The changes you make will apply
to whatever objects are selected. 

To select a single object: 

Click the ITEM button until the object is selected or use the 
Pointer to click on the object. Solid black handles will appear at
each corner of the object. (Handles will appear in other colors if
black won’t show up well against your background.) The handles
tell you that the object is selected. To de-select the object, click 
elsewhere on the design. Pressing the Tab key on the keyboard
or clicking the ITEM button on the main screen will select each
object on the sticker in turn.  This feature is especially useful
when several objects overlap each other.

To select additional objects: 

Hold down the Shift key as you click each additional object. To
de-select the objects, click elsewhere on the design. 

T H E  B A S I C S
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To select all of the objects in the design:

Choose Select All from the Edit menu. To de-select the objects,
click elsewhere on the design (not on a selected object).

Moving Objects

To move an object, position the Pointer over the object, click and
hold the mouse button, and drag the object to the desired 
location on the sticker. 

Scaling an Object
To scale an object, click once on the object to select it, or click
the ITEM button until the object is selected.  Next, position the
Pointer over one of the “handles” on the corners of the selected
object.  These handles appear as small boxes.  Click the mouse
button and hold it while dragging the handle away from or
toward the center of the object.

Stretching an Object
Select the item that you wish to stretch by using the mouse 
pointer or the ITEM button.  Next, position the Pointer over one
of the handles on the corners of the selected object.  While 
holding down the Ctrl key on the keyboard, click and hold the
mouse button while dragging the handle away from the center 
of the object.  

Menu Functions

Across the top of the screen is the Menu Bar.  To open a menu,
click the name of the menu and hold the mouse button down.  
A list of items will appear.  While still holding the mouse button
down, move the Pointer over the items.  The items will become
highlighted as the Pointer moves over them.  To select an item,
let go of the mouse button when that item’s name is highlighted.

Some menu items won’t be available until an object is selected.
These menu items are gray and are referred to as being “grayed
out.”  To make these menu items active, you must first select an
object in your design.

TTHHEE  MMAAIINN  SSCCRREEEENN
To get to the main screen, you must first start the Sticker
Works application.  To do this, double click on the Sticker
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Works icon located within the Sticker Works program group
in Windows Program Manager. 

To make learning how to use this software a little easier, we
have broken down the main screen into four parts.

TTHHEE  ZZOONNEE
Sticker Works's main screen centers on the cre-
ation of your sticker design.  The big circular area in
the center of the screen is called The Zone.  That’s
where you place and move objects.  

Although you can move objects so that they fall out-
side The Zone, only those objects, or parts of
objects, that lie within The Zone will be printed.

TTHHEE  GGRRIIDD
The Grid is the rectangular area just below The
Zone.  It contains two arrows (one pointing left, one
right) and 20 dots laid out in a grid pattern.  

The arrows allow you to move from one sticker to another. Click
once on the left arrow to go to the previous sticker design. Click
once on the right arrow to move to the next sticker. Each dot rep-
resents one of the 20 labels on the sheet you will eventually feed
through your printer.

If you just started the application, all of the dots are yellow and
there is a blue circle around the dot in the upper left corner. This
blue circle lets you know which sticker you are working on.  

The yellow dots represent stickers with nothing in them.
Therefore, if you were to print your project right now, you would
get nothing but white labels.

Note: If any of the dots are red in The Grid you probably want
to avoid designing a sticker in them. Your printer may not be
capable of fully printing that close to the edge of the page. You
won’t be prevented from designing in those areas, so if you
want ”to see what happens,” feel free!
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Once you have created a sticker design and move to the next
sticker, the color of the corresponding dot in The Grid will turn
green.  This makes it easy to see which stickers are finished (or
partially designed), and which ones are still empty.  If the top
row of dots is green and you print your project, the top row of
the printed label sheet would contain sticker designs.  If you
were to delete all of the objects from a given sticker, the 
corresponding dot in The Grid would turn yellow again.

Jumping to Stickers

Move the cursor into The Grid.  Now click on a dot in The Grid
other than the one that is active.  

The blue border will jump to that dot you just clicked on and that
sticker will become active.  Any contents of that sticker will be
shown in The Zone.  You can add or edit objects for this sticker
since it is now the active sticker.

Moving & Copying Stickers

You can move stickers from one location in The Grid to
another within your current project. To move a sticker,
click on it and, while holding down the mouse button,
drag it to the desired location.  Releasing the mouse but-
ton will move the sticker design to that location.  You can
also copy a design by holding down the Shift key on the
keyboard while dragging a design from one area in The
Grid to the another.

TTHHEE  LLEEFFTT  BBAANNKK
The Left Bank controls allow you to modify a selected object’s
attributes, delete a selected object, undo a modification or 
function, and save the project.

The COLOR, TINT, ROTATE and FLIP buttons can only be used
when an object is selected.

Color

Color can be applied to text or to a black and white graphic. To
select a color for an object, make sure the object is selected and
then click and hold the mouse button down on the COLOR
button.  A pop-up window with a selection of 256 colors will
appear.  
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While holding the mouse button down, move the Pointer over the
colors.  The center of the COLOR button will change to show
you which color the Pointer is over.  To apply the selected color,
let go of the mouse button.  The selected object
will change to that color.  Remember, this only
works for Text and Black and White 
graphics.

Tint

The TINT button allows you to fade an object’s
color in steps of ten percent. Ten percent is the
minimum tint value. To tint an object, make sure
that it is selected and then click and hold the
mouse button down on the TINT button. Move the mouse so that
the TINT button turns.  You’ll notice that as you rotate the TINT
button, the button itself will fade. When you’ve found a tint effect
that you like, let go of the mouse button. The object you selected
will tint accordingly.

Note: Monochrome (black and white) and imported graphics
cannot be tinted.

Flip
You can flip a selected object by clicking the FLIP button.  First,
select an object and click either the top or bottom of the button
(vertical flip), or the left or right side of the button (horizontal
flip).  

Rotate
The ROTATE button allows you to rotate an object in 10 degree
increments. To rotate an object, make sure that it is selected and
then click and hold the mouse button down on the ROTATE but-
ton. Move the mouse so that the ROTATE button begins to turn.
When you’ve turned the button to a degree you want, let go of
the mouse button. The selected objects will rotate accordingly.

Note: Imported Graphics can be rotated in 90° increments only. 

Undo
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Clicking UNDO will reverse that last thing you did.  It will only
undo your last action.  If you do something to your design that
you didn’t mean to do, then select UNDO right away. 

Delete

If an object is selected in your sticker, DELETE will remove that
object.  You can also delete selected objects by pressing the
Delete key on your keyboard.  The object does not get moved to
the Clipboard.  So, if you DELETE something by mistake, make
sure you UNDO right away.

Save As

Click the Save As... button to create a file for your work.  

• In the name field, type in a name for your creation.  

If you have saved the project once before, the name will already
be filled in for you.  If you’d like to change the name, simply
type in a new name.  

You will also notice a description field.  Either press the Tab key
or click in this field to make it active.

• Enter a description for your project.  

Enter a description that will let you know what designs are in this
project when you go to open it or transport a sticker from it later.  

Save Mode

When saving a project, you have two options. Fast Save saves
a compact form of your project. This feature conserves disk
space using “pointers” to graphic files rather than creating 
duplicate copies of full graphic files. Full Save saves all files 
necessary to use your project with another copy of Sticker
Works on a different computer. For example, use Full Save
when you want to print a project on a printer attached to 
another computer.
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After you have entered a name and a description for your 
project, click on the OK button.

TTHHEE  RRIIGGHHTT  BBAANNKK
The Right Bank controls allow you to add objects, import other
stickers, select and edit items, and print your project.

Fill

Click the FILL button and the Fill dialog will appear. Here you
can select from 7 different Blend Options and choose the col-
ors for those effects.

• Select a Blend Option for the 
background of your sticker.

Click the radio button near the name of the effect you want.
After selecting an effect, a preview of that effect will be shown in
the right side of the dialog.

• Click in the Fill Color Area to choose the
first color of the effect.

• Click in the Blend Color area to choose the
second color. 

As you select colors, they will be added to the
preview of the effect so you can see how well
they work together.  

Note: If you pick No Fill as the Blend
Option, Fill and Blend are not applicable.  If you pick Solid as
the Blend Option, only Fill Color is applicable.

After you have selected your Blend Option and Colors, click
the ADD button to add the background to your design. Or, you
can click the CANCEL button to leave your design unchanged.
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Add Graphic

Click the GRAPHIC button, and the Add a Graphic dialog will
appear. Here you can choose to add or import a graphic into
your design.

You can add a Center or Border Graphic to your design by click-
ing the radio button next to those names.  You can
also choose to add a Print Shop Square graphic
by selecting that radio button.  The Import button
enables you to import any graphic that is in BMP,
TIFF, EPS or WMF format. (Read further down in
this section for more information on imported
graphics).

After you have selected the graphic type, a list of
available graphics of that graphic type in the cur-
rent directory will appear at the left of the dialog.

The name of the graphic library that holds these graphics will
appear at the top of that list. If you want to add a graphic from
another library, click in the library name field and choose anoth-
er name from the list that pops up.  If the library name you are
looking for does not appear in the list, then click “Other
Libraries...” and use the navigational 
dialog to locate the library on your hard drive or floppy disk.  If
you want a library or file from another directory, double click on
the desired directory or click on the “[..]” symbol in the
Directories list to move back one directory level.  If you want a
library from another Drive, double-click on the drive letter near
the bottom of the Directories list.

To preview a graphic before you add it to your design, click on
the name of the graphic in the list.  A preview of that graphic
will appear in the right side of the dialog.  Scroll down the list to
locate additional graphics in the selected library.  

Finally, there is a checkbox with the caption Fit to Sticker.
This means that the graphic object you add will be automatically
sized to fit to the boundary of the sticker if this option is 
selected.  If you deselect this option by removing the check mark
(just click on it), the graphic object will be placed onto your
design at a smaller size.
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Once you’ve found a graphic you wish to add to your design,
click the ADD button, or click the graphic name twice. To leave
your design untouched, click the CANCEL button.

You can add as many graphic objects as you like to any one
particular design, with the exception of Border Graphics.  Only
one Border Graphic can be added to any one sticker design.

Importing Graphics in other formats

If you choose to import a graphic or photo that is in either BMP,
TIFF, EPS or WMF format, click the Import button in the Add a
Graphic dialog.  In the Import Graphic dialog, choose the type
of graphic you want to import from the drop down list.  A list of
the available graphics of that type in the current directory will
appear in the Files list box.  To preview a graphic, click its name
in the Files list box.  The preview will show in the display area to
the right.  If necessary, navigate to the appropriate drive and
directory.  Select the graphic or photo you want and click ADD.
The graphic will appear in the middle of The Zone, where you
can resize and move it.

Note: Imported graphics can only be rotated in 90 degree
increments, and they cannot be tinted or have their color
changed.

Add Text

Click the TEXT button and the Add Text dialog will appear.
Here you can select a text effect and enter the text you want to
add to your design.

You may enter up to two lines of text.  Each line of text is repre-
sented by a text entry field at the top of the Add Text dialog.

•Type in a line of text.

•Press the Tab key to advance to the second text field.

•Add another line of text if you wish.

Hint: Do not enter too many characters on one line.  A sticker is
only 1 1/2” in diameter.  Trying to put a lot of text on one line
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may make your phrase unreadable.  Try to keep the amount of
text you enter to 20 characters or fewer per line, and you will
find your message much easier to read when your design is
printed.

Font

Below the text entry area is a pop-up list of typefaces.  The
default font is always chosen automatically, but you can change
this by clicking once on the typeface currently shown.  From the
pop-up menu that appears, select the typeface you want.  Scroll
up and down in the list of fonts to see all your typeface options.

To select a font, just click on it.

Shape

The next option is Shape.  Select a shape for your
text from the pop-up shape menu.  Your text will
be stretched and squeezed to fit the shape you
select.  The “Border Text” option will stretch your
text around the border of your sticker in a circular
shape.

Justify

Justification refers to the alignment of text.  This option is only
available if you have two lines of text.  To select justification,
click on the name of the current justification setting or on the
down arrow to the right of the current justification.  Select the
desired justification.  If you choose “Full”, the text will be
stretched so that it spans the full distance from the left margin to
the right margin of the text block.

Note: Justify is not an option if you select “Border Text.”

Finally, there are three boxes with the options Bold, Italic and
Fit to Sticker.  Choose Bold or Italic to add those options to
your typefaces.  If the Fit to Sticker box has a checkmark in it,
the text object you add will be automatically sized to fit to the
edge of the sticker.  If you deselect this option by removing the
check (just click on it), the text object will be placed onto your
design at a slightly smaller size.

When you are finished choosing your text effects, click the ADD
button to add the text to your sticker.  If you decide you don’t
want to add the text, click the CANCEL button.  You can add as
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many text objects as you’d like to any one particular design,
with the exception of Border Text.  Only one Border Text object
can be added to any one sticker design.

Transporting a Sticker

Click the TRANSPORT button to add a sticker
design from a saved project to your current 
project.  

A list of saved projects will appear in the left side
of the dialog.  When you’ve decided which file
you want to open, click that file’s name to highlight
it.  A preview of the first 
sticker will appear in the right side of the dialog.
Click the left or right arrows below the 
preview to see the different designs in the 
project.  When you’ve located the design you
want, click the OK button.  This will add that design to your cur-
rent project, and into the currently selected sticker.

Note: Make sure you select an empty sticker on your current
project before transporting a sticker from a previously saved pro-
ject.

Item

Clicking the ITEM button is like pressing your
Tab key to select objects.  Each time you click
the ITEM button, a different object will be
selected in The Zone.  Sometimes, when there
are many overlapping objects in The Zone,
clicking the ITEM button makes it easier to
select the object you want to modify.

Edit

Clicking the EDIT button will bring up the appropriate dialog for
the selected object, so you can modify or change that object.

Print
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Click the PRINT button to print your project.  Within the
Print dialog you will notice the following options:

Printer Setup

This feature lets you specify a printer from a list of currently
installed Windows printer drivers.  It also allows you to configure
that printer’s settings.

Print Alignment

This feature allows you to move your project in very small 
increments, up to a total of one inch, in any direction.  If your
project is not placed properly on the label sheet when you print
it, the Print Alignment command lets you “nudge” it into the 
correct position.  Click the Print Alignment button to go to the
Print Alignment dialog.  Enter numbers from -15 to 15 in the
Horizontal and Vertical alignment boxes to move your projects
slightly left (-), right (+), up (-), or down (+) on the page.  To go
back to the previously saved setting, click the Reset button.

All Stickers

Choose this option to print all the stickers in the open project.
Make sure you insert a sheet of labels into your printer.

Current Sticker Only

This option will print only the sticker that is active.  This will print
both a large size and an actual size preview of your 
sticker design.  If you select this option, print on a plain piece of
paper and not on a sheet of labels.

Test Print

This will print a sheet of circles for a paper alignment test.  Make
sure, if this option is selected, that you print on a plain piece of
paper and not on a sheet of labels.  Use the resulting printout to
adjust Sticker Works and your printer. Compare the test sheet
with a label sheet to verify the alignment is correct.  For details
on printer setup, see The Menus, starting on page 23.

Print with Border

Selecting the Print with Border option will produce a circular
border around each of your sticker designs when printed.  To
select this option, click once on the box next to it and a check
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will appear.  To deselect the option, just click once again and
the checkmark will disappear.

Note: If you select Test Print, the Print with Border option
is automatically selected and cannot be deselected.

Number of Copies

If you want to print more than one copy of your project, highlight
the number in the Number of Copies box and type in the
number of copies you want.

Scale Percentage

If you would like to scale the printout, enter or adjust
the scaling percentage shown. The default printout is
100%. However, you can have your stickers print out
anywhere from 50% to 103% of their original size.  This
feature can be used to effect a 
“bleed”– a sticker that prints off the edge of the label.  It can
also be used to shrink the sticker printouts so that they will line
up on the sheet of labels better.  Be careful when trying to 
correct a bleed off the edge of a label.  The labels themselves
are positioned close to each other and if your printer is not prop-
erly adjusted, a design intended to print on one sticker may
bleed onto another.

Coloring Book

This option prints any project in outline form.  To select this
option, click once on the box next to the option so a checkmark
appears.  If you do not want to print in Coloring Book mode,
make sure there is not a check next to this option.

When you are ready to print, click the PRINT button.

Note: Always try to fill up an entire project before printing out
to a label sheet.  Although you can move and reposition stickers
within the Grid to make use of unused labels, the glue that holds
the labels on the wax backing of the sheet begins breaking
down after a few runs through the printer. Also, previously
removed labels leave plain wax paper exposed.  If you do feed
a label sheet back through your printer, make sure that no sticker
designs exist where there isn't a label to print on (this note is
especially for you inkjet owners).
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FFIILLEE  MMEENNUU
New Sheet

Choose New Sheet to start a new project. 

Open...

Choose Open... to open files you have previously saved.  A list
of saved files will appear.  When you’ve decided which file you
want to open, click twice on that file’s name or highlight the
name and then click the OK button.  The first sticker in that pro-
ject will appear in The Zone and then you can edit, print or fin-
ish the project.

Save

Select the Save option to create a file for your work.  For more
information on Saving, see page 16.

Save As...

Choose this option to save a project for the first time or to save a
currently open sheet with a different name.  For more information
on Saving, see page 16.

Revert to Saved

Use this option to switch back to the last saved version of your
project.

Preferences...

This option lets you set preferences (defaults) that Sticker
Works will use whenever you start the program.  Make your
desired selections in the dialog box that appears.

Sound – use this option to turn on or off the button sounds
you hear while working with Sticker Works.

Default Font – this font will be used each time you create
a new text block.

T H E  M E N U S
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Fast Bitmap Printing – by default, this should be 
checked.  This will print your projects as fast as possible.  
However, if your printer is having difficulty printing flipped 
or rotated imported graphics, deselect this option by 
clicking on it to remove the checkmark.

Print...

Choose Print... to print your project.  For more information on
printing, see page 20.

Print Setup...

This dialog lists the currently available Windows printer drivers.
One printer or several may be listed, depending on what you
specified when you installed Windows. Click on the printer you
want to use.  If you want to set options for the printer, click the
SET-UP button.  This will bring up the Setup dialog for 
the printer. 

Note: The Windows printer drivers and the Setup dialog are
supplied by Windows and/or the printer manufacturer, not 
Sticker Works. If you are experiencing difficulties printing, please
check the Sticker Works ReadMe file or contact your printer 
manufacturer.

Exit

Select Exit from the File menu when you want to quit the appli-
cation.

EEDDIITT  MMEENNUU
Undo

Selecting Undo will reverse the last thing you did.  It will only
undo your last action.  If you do something to your design that
you didn’t mean to do, select Undo right away. After you
Undo an action, the menu command will change to Redo.
Redo will reverse the last Undo command.

Cut

Cut will remove the selected object from your design and move
it to the Clipboard.  
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Copy

Copy will make a copy of the selected object and put the copy
onto the Clipboard.

Paste

If you have an object that has been moved or copied to the
Clipboard, Paste will place a copy of that object onto the
active sticker.

Delete

If an object is selected in your sticker, Delete will remove that
object.  You can also delete selected objects by pressing the
Delete key on your keyboard.  Note that the object does not get
moved to the Clipboard.  If you Delete something by mistake,
make sure you Undo right away.

Duplicate

This option makes a copy of the selected object(s) and pastes
them on top of the current object(s).  Use this menu command to
create a copy of a selected object and paste it in one quick step.

Clear All

Use this menu command to quickly delete all the graphic and
text objects in the active sticker.  This can be easier than deleting
each object individually.

Select All

Select All is a quick way to select every object that is on the
current sticker.

OOBBJJEECCTT
Add Graphic...

Selecting this menu item is just like clicking the GRAPHIC button
on the screen.  The Add a Graphic dialog will appear and you
can choose to add or import a graphic into your design.  See
page 18 for more info.
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Add Text... 

Selecting this menu item is just like clicking the TEXT button on
the screen.  The Add Text dialog will appear, where you can
select a text effect and enter the text you want to add to your
design. See page 20 for more info.

Edit 

Selecting this menu item is just like clicking the EDIT button on
the screen.  Selecting EDIT will bring up the appropriate dialog
for a selected object, so you can modify or change that object.

Shadow 

An object must be selected first in order to choose Shadow
from the Object menu.  When you hold the mouse button down
on Shadow, you can choose to turn Shadow On or Off. Turn-
ing Shadow On will add a shadow to the selected object.

Order

Select Order to move objects in front or behind other objects in
your design.  After selecting an object, select Order from the
Object menu and drag your mouse over a position from the
pop-up menu that appears.  To select a position, let go of the
mouse button when the position you want is highlighted.

Bring Forward Moves object forward one layer
Bring to Front Moves object to the top most layer
Send Backward Moves object backward one layer
Send to Back Moves object to bottom most layer

Note: The fill will always be the bottom most layer. You cannot
use the Order command to place anything behind a fill. 

Scale... 

Instead of dragging an object’s handle to resize it, Scale...
allows you to enter an exact resizing percentage.   After select-
ing an object and choosing Scale... from the menu, a dialog
appears where you can enter a percentage between 1 and 200
percent.  You can type in the field or use the up and down
arrows to enter a value.  When finished, click OK to scale the
selected objects.
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Rotate 

Rotate allows you to rotate the selected object by a specific
number of degrees.  In the Rotate dialog, type in a value or use
the up and down arrows.  When finished, click OK to rotate the
selected objects.

Flip 

Click and hold on Flip in the Object menu to see a pop-up
menu of selections.  To select a direction, let go of the mouse but-
ton when the direction you want is highlighted.

Snap to Center 

Snap to Center will move each of the selected objects so that
its center is aligned with the center of the sticker.

PPRROOJJEECCTT
Transport Sticker...

Select Transport Sticker... to add a sticker design from a
saved project to your current project.  A list of saved projects will
appear.  When you’ve decided which file you want to open,
click that file’s name to highlight it.  A preview of the first sticker
will appear in the right side of the dialog.  Click the left or right
arrows below the preview to see the different designs in
the project.

When you’ve located the design you want click the ADD button.
This design will be added to the active sticker in your current
project.

Fill...

Selecting this menu item is just like clicking the FILL button on the
screen.  The Fill dialog will appear, where you can select a fill
effect and choose the colors you want to add to the background.

Next Sticker

Selecting this menu item is just like clicking the right arrow on the
screen.  Next Sticker will advance you to the next sticker in
the open project.  
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Previous Sticker

Selecting this menu item is just like clicking on the left arrow on
the screen.  Previous Sticker will revert you to the previous
sticker in the open project.  

Turn Sound On/Off

Select Turn Sound Off to turn off all button sound effects for
this session of Sticker Works. When the sound is off, the 
command “toggles” to Turn Sound On, which you can select
to hear button sounds again.

Note: If you want sound off to be the default setting, choose
Preferences in the File menu and select Sound Off.  Button
sounds will remain off until you change your selection in
Preferences or you toggle the sound on using the option under
the Project menu.

HHEELLPP  
Index...

Displays an index of Sticker Works Help topics.

Using Help

Use this menu command to view help on using the
Help system.

About...

Select About... to see the names of the people who creat-
ed the Sticker Works software.
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How to Contact Technical Support

If you have worked through these troubleshooting suggestions and
still need assistance, you can contact Brøderbund Technical
Support by using the options listed below.  It will be very helpful if
you can tell us your computer make and model, and the brand
names of both the video card and sound card you are using.  If
possible, have the computer both positioned near your phone and
turned on.  Please also be prepared to give us a detailed descrip-
tion of what happens when you try to run the program.

You can contact us in any of the following ways:

•Internet - Online support is available through our World 
Wide Web site at http://www.broderbund.com/support

•America Online® - Use the Keyword: BRODERBUND

•Mail - Send your questions to Brøderbund Technical 
Correspondence, P.O. Box 6125, Novato, CA  94948-
6125.

•Phone - Call us at (415) 382-4700 from Monday through
Friday between the hours of 6:00 a.m. and 5:00 p.m.,
Pacific Time.
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